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1 Introduction

The Hybrid Synthesizer™ is an add-on software tool for CES EduPack™ and CES Selector™ that enables the
performance of new materials and structures to be predicted, based on the properties of ‘standard’
materials in the installed databases. The potential benefits of these materials can then be studied by
comparing them with other materials using the visualization and selection tools within the software.

Although the Hybrid Synthesizer is supplied with a range of standard models, it is also possible to add your
own. The aim of this document (and associated sample files) is to show you how to write, create, and run
your own custom model in the Hybrid Synthesizer.

In order to implement a custom model successfully, you will need:

e Access to Microsoft Visual Studio.
e Administrator rights on your PC.
e Details of your model calculations.

Also note, the material properties required by the calculations must be available in the installed database.

It should be highlighted that, although your model will need to be written in code, this writer’s guide is
aimed at engineers and scientists with little, or no, coding experience. As a result, the use of technical coding
terminology has been kept to a minimum and all example code is supplied in the accompanying sample files.

Two sample files are distributed with this guide. These are installed with the software and can be found in
the Samples folder in the installation location (e.g., C:\Program Files (x86) \ CES xxxxxxx \ Samples \
hybrid_synthesizer)

The first (Simple) model focuses on the basic model structure and explains how to create the user-input
screen and add simple calculations. This example will enable you to create a simple model that runs in the
Hybrid Synthesizer.

The second (Advanced) model focuses more on the calculation code and shows you how to add complexity
to the model calculations. Both these sample files are intended to be used as starting templates for your
own models.



2 Pre-requisites for Model Writing

2.1 Microsoft Visual Studio

The Hybrid Synthesizer uses a plugin architecture that allows new models to be added. Although these
models need to be written in .Net (typically either C# or Visual Basic) they have been designed to require
minimal programming knowledge. Writing a basic model is relatively simple once you’'ve grasped a few
basics.

To create a model you will need to use Microsoft Visual Studio. This comes in many flavors but for this
tutorial we will use the 2012 free edition, Microsoft Visual Studio Express 2012 for Windows Desktop’,
which has everything we need to create models. Express editions of Visual Studio can be downloaded from
here:

http://www.microsoft.com/visualstudio/eng/products/visual-studio-express-products

You will be using .Net version 4.

2.2 Example Files
The example files distributed with this tutorial are for both Visual C# and Visual Basic and have everything
needed to build a model. There are two sample models;

1. A Simple model which calculates density and Young’s modulus for a hybrid material based on the
rule of mixtures.

2. An Advanced model which introduces additional concepts, such as how to use standard functions,
reuse of equations, and applying logic in calculations.

The folder layout will look something like this:

4 ExampleModels
4 C#
Advanced
Simple
4 VB
Advanced
Simple

The folder for the C# Simple model:

U“] Simple.cs This file contains the code of the model

r-gu-ﬂ Simple.CSharp.csproj  The Visual Studio project

=1

“a Simple.CSharp.sin The Visual Studio solution file
B modelpng Contains the image for the model
B thumbnail.png Contains a thumbnail image for the model group

You can open an example file for editing in Visual Studio by double-clicking the .sIn file in the C# or VB folder,
e.g., Examples.CSharp.sin, and then, depending on which model you want, opening the Simple.cs or
Advanced.cs file in the application.

' To install this software, you will need to be using Windows 7 SP1, Windows 8 Desktop, Windows Server 2008 R2 SP1,
or Windows Server 2012.


http://www.microsoft.com/visualstudio/eng/products/visual-studio-express-products

2.3 Creating a Model File

It is a good idea to start your own model by making a copy of the Simple example. In this way, you can
modify it without affecting the original. If you copy the Simple folder (for C# or VB) plus the lib folder, then
you should have everything you need, but if you just copy the Simple folder, then you will need to manually
add a reference to Granta.Data.dll and Granta.HybridBase.dll. The steps to do this are shown in Appendix B.

If you wish to change the file name of the model, this can be done by using the Project menu and selecting
Properties, the last entry in the menu. In Application, change the Assembly name to the name of your
model. Again, see Appendix B for details on how to do this.



3 Overview of a Model File

In order to create a model, you will need to write code similar to that listed below. This shows all the code
required to configure the user interface and specify the model calculations for the Simple model.

using System;

using System.ComponentModel.Composition;
using Granta.HybridBase;

1 Required to build model

namespace UserModel

{

public class SourceData

{

[Data("Density", "kg/m”3")]
public double Density; List of all properties used in

model calculations

[Data("Young's modulus", "GPa")]
public double YoungsModulus;

[Export("Granta.HybridModel")]

[Model("Simple Model (C#)", "A simple example model.")]

[Image("UserModel.model.png")] Model name, images and

[ModelGroup("Examples", “UserModel.thumbnail.png”)] description
public class ExampleModel

{

[Material("Matrix", "Matrix material")]
public SourceData matrix; Details of ‘Source material’

[Material("Reinforcement", "Reinforcement material")] user inputs

public SourceData reinforcement;

no/n
°

[Variable("Reinforcement percentage",
"Specify the volume fraction")] . . . ,
[RangeValues(Start = 10, End = 70, 5 Details of ‘Model variable
Number = 7, Logarithmic = false)] and/or ‘Model parameter’

[Bounds (@, 70)] user inputs
public double percentage;

[CalculatedData("Density", "kg/m~3")]
public double Density()
{
return (percentage / 100.0) * reinforcement.Density
+ (1 - percentage / 100) * matrix.Density;

6 Model calculations

}

[CalculatedData("Young's modulus", "GPa")]
public double YoungsModulus()
{

return (percentage / 100.0) * reinforcement.YoungsModulus
+ (1 - percentage / 100) * matrix.YoungsModulus;

} 7 Required to build mode




4 Defining a Model: Part 1—A Simple Model

4.1 The Input Screen
A Hybrid Synthesizer model typically requires a number of things to be specified:

e One or more source materials.
e Some model variables, and/or parameters.
e The calculations that predict the performance of the hybrid material.

Some of these (such as the calculations) are defined in the model, and some are entered by the user when
they run the model. The input screen allows the user to set up the model and fill in these values. Once all the
inputs have been set, the user clicks Create to run the model, which starts the calculation process. When you
create a custom model, you don’t need to worry about designing the input screen—the Hybrid Synthesizer
will create it automatically based on your model data.

The Simple example model shown here requires two source materials: a matrix and a reinforcement. From
this screen, the user can pick materials from the database and assign them to these roles.

The example also includes one model variable—the [& . ==

Simple Model (C#)

reinforcement volume fraction (%). The default range of -
10-70% has been set by the model, as has the number
of values (7). This means that the model will call (use)

the calculation code seven times, once for each

percentage value between 10% and 70% (that is, for || w (B n dersty concree [ sronse. |
ValueS Of 10' 20' 30' 40' 50’ 60 and 70) and create seven Reinforcement B Carbon stee), 5A216 (Type WCC), cast, annesled | [ Erowse. |

Model Variables

synthesized records. The user can overwrite these [| oo formomee i3 dorte
Reinfol ent 10-70 % Number of values: 7

defaults and enter their own choice of values. Record Naming

Name Reinforced Concrete

Finally, in order to allow the model to generate names

This model will generate 7 records [ previous |[ create | [ cancel |

for the synthesized records, the user must enter an
abbreviated name to be applied to the resulting records. Without this step, the resulting record names
would be overly long and unworkable.

Remember that you don’t need to create the user interface; just define the data that you need, and the
Hybrid Synthesizer will do the rest.

4.2 Terminology

To write a custom model, you’ll first need to understand some basic programming terminology. Our model
will need to group data together in the form of source material properties (such as density or Young's
modulus) and additional user inputs (such as reinforcement volume fraction), and then perform some
calculations on that data in order to predict the performance of the hybrid material. Both the data and the
behavior of the model will be encapsulated by a programming structure known as an object or a class. Data
values will be stored in fields which can hold data of a specific type. Numerical data is described as being of
type double—short for double floating point—which is simply the way in which the computer stores
numbers. Calculations—the behavior of the model—will be stored in methods of the class. Methods consist
of pieces of procedural code that form the logic of the model.



Note: throughout the code samples you'll also see the word public. This is an access modifier and means that
your model class and its member variables and methods will be accessible to the Hybrid Synthesizer.

4.3 Defining ‘Source Data’

The Simple example model calculates density (p) and Young’s modulus (E) for a hybrid material by applying
the rule of mixtures to the matrix (m) and reinforcement (r) properties, using the following equations (where
f is the reinforcement volume fraction):

Density, p = fpr + (1 = f)pm
Young’s modulus, £ = fE,. + (1 — f)E,

In order to calculate this, the model needs to access the density and Young’s modulus for both source
materials. This is done by creating a SourceData class and defining a field for each material property that the
model calculations require. Each material property is stored as a value of type double. Fields are defined
using the following format:

public double FieldName;

The Hybrid Synthesizer will automatically fetch the source material data from the installed database and
store it in the SourceData class, ready for calculation. To enable this, mark up each field with the property
name exactly as it appears in the database, and the unit:

[Data("Property Name", "unit")]

If the data you are interested in doesn’t have a unit, you can leave it blank, but for other values you will need
to include the unit that you wish to perform the calculation in. The Hybrid Synthesizer will automatically
convert material data into the unit that you require, making your calculations easier.

Note: When using Price, you will need to specify the unit as ‘currency/kg’. For example:

[Data("Price", "currency/kg")]
public double Price;

The example shown below creates a class named SourceData that stores data for Density with a unit of
kg/m43 and Young’s modulus with a unit of GPa.

public class SourceData

{
[Data("Density", "kg/m~3")]
public double Density;
[Data("Young's modulus", "GPa")]
public double YoungsModulus;

}

You can add as many data fields as you require, although they must map to material properties in the
installed database. Remember, the Hybrid Synthesizer will automatically fetch data for each source material
in the correct unit, ready for calculation. Make sure that the “Property Name” that you use to mark up each
field is identical to that in the database.



4.4 Defining the Model
Each Hybrid Synthesizer model must be created using a =

class. It’s a good idea to give your model a suitable class | ™™=

Choose a model

name—our example is named ExampleModel (see the

last line in the code below) but yours should probably b EE':":QEQ;}LQE,‘”EE O | e e
be more descriptive. The class name is not the same as P or j ) S

the name of the model as it appears in the user @ ?"”‘;LE‘QT“E”“‘*'E”P*”S“’" R, e
interface—we will come to that below. Note that you s

cannot put spaces in the class name. % i é —

In order for your model to appear in the Hybrid

Synthesizer, the model class must be marked up as

Cancel |
follows:

[Export("Granta.HybridModel")]

You can set the model name that will appear in the user interface, along with a description, by adding the
following mark up:

[Model("Name", "Description")]

The user interface will display the name on the welcome screen, as shown above. The description is used as
the description of the model on the next screen.

You can set the image that will appear in the user interface by adding the following markup:
[Image("UserModel.ImageFileName.png")]

It is often useful to group related models together and the Hybrid Synthesizer allows you to do so for your
custom models. You can group related models using the following markup:

[ModelGroup("GroupName", "UserModel.ImageFileName.png")]

“GroupName” corresponds to the group name that will appear on the welcome screen and the
ImageFileName will be the corresponding image for the group. In order for two or more models to share the
same group, the GroupName and ImageFileName must be identical for each model in the group.

[Export("Granta.HybridModel")]
[Model("Simple Model (C#)", "A simple model

showing how to write a hybrid model")]
[Image("UserModel.model.png")]
[ModelGroup("Examples", “UserModel.thumbnail.png”)]
public class ExampleModel
{

}
These are the only lines of code you need for your model to appear in the Hybrid Synthesizer! But it won’t do
anything as it stands. If you pick this model, you'll get an empty input screen. You’ll need to flesh out the
model with source materials, user inputs, and calculations.



4.5 Adding Source Materials to the Model

Source Materials are created by adding fields to the model class and marking them as materials.

The type of each source material field must be the name of the class in which you defined and stored the
source material properties (as in section 4.3)—in our example, that class is named SourceData.

For example, we can define a field for the matrix material in our model:
public SourceData matrix;

Mark up each source material field as follows:
[Material("Name", "Description")]

The "Name" value is used to label the material in the ‘Source Records’ section of the user interface and the
"Description” is used to provide extra information in the form of a tooltip. The "Name" label also appears in
the ‘Record Naming’ section at the bottom of the user interface; this is where the user enters abbreviations
for the source materials so that suitable record names can be created for the resulting records. The Hybrid
Synthesizer will generate these user interface elements for you; all you need to provide is the name and
description.

You can add as many materials as you like. The example below shows the two materials required for our
hybrid material—a matrix and a reinforcement:

public class ExampleModel

{

[Material("Matrix", "Matrix material")]
public SourceData matrix;

[Material("Reinforcement",
"Reinforcement material")]
public SourceData reinforcement;

}

4.6 Adding Model Variables

The Hybrid Synthesizer is capable of calculating a family of records in one analysis. This can be achieved by
defining a user specified model variable, such as the reinforcement volume fraction in the Simple model
example.

Model variables can be specified either as a range of discrete values — with start and end values, and a
number specifying the steps in between—or as a list of given values. Note, model parameters, which are
single value constants that can be specified by the user, are discussed in the advanced model example (see
section 6.1).

You will typically use one or more variables in your calculation code, and for each one, the Hybrid
Synthesizer will fill in your field with each specified value in turn. This means that your calculation methods
will be called several times—once for each value or combination of values.
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Variables are added to the model by creating a field of type double in the model class and marking it as a
variable by using the following, where the name and unit are shown in the user interface, and the
description is used as a tooltip:

[variable("Name", "Unit", "Description")]
Optionally, you can specify default values for the variable, either as a list or as a range:

[Values(10, 20, 30)]
[RangeValues(Start = 1, End = 25, Number = 5)]

In the example below, we have created a variable which we’ve named percentage. It holds values for
reinforcement volume fraction (%), defaulting to seven numbers between 10 and 70. By default, values
within a range are created at logarithmic intervals, but in this Simple example we just want linear values, and
so we’ve added logarithmic=false. We have also defined bounds that specify that the values cannot go
below 0 or above 70. The bounds are used by the Hybrid Synthesizer to validate the user input and make
sure that the user enters valid values for the model variables.

[Variable("Reinforcement percentage", "%",
"Specify the volume fraction")]
[RangeValues(Start = 10, End = 70,
Number = 7, Logarithmic = false)]
[Bounds (@, 70)]
public double percentage;

4.7 Calculations
By now you should have enough input data available to & (==

perform the real work of the model—the calculations.

Continuous fiber (UD & QI)
Predicts the performance of continuous fiber reinforced materials

Unidirectional = alligned fiber lay-up (0]
Quasi-isotropic = multi-axial lay-up [0%/+45°/-45"/90%]s
Fiber, >
i “
‘Mull'lxl ‘f ® Uni ent distribution
% | e Perfect | bondir

Unidirectional Quasi-isotropic | Material is fully dense

Remember that calculations form the behavior of the

z

model, and are written as methods in the model class. m

You’ll need to write a calculation method for each

material property that you want to calculate.

Results

The method must return the calculated value as a value o)
Calculating...

of type double, and be marked up as calculation data:

[CalculatedData("Property Name", "unit")]
This model will generate 6 records Previous | Finish |

Just like the markup added to source materials, you
should specify the name of the material property you are calculating, plus the unit that you are returning the
result in. Note, the “Property Name” needs to be identical to a property in the installed database if you want
the calculated data to be available for selection projects. If the “Property Name” does not match any of the
properties in the database, the calculated property will be added to the Notes field at the bottom of the
synthesized record’s datasheet.

Calculation methods are called automatically by the Hybrid Synthesizer, which will set the values of the
parameters and variables accordingly. You can add as many calculation methods as your model needs and
they will all be called by the Hybrid Synthesizer once for each combination of variables. As our example
stands, this means that the calculation code is called seven times (we have seven reinforcement values) and
the model will create seven synthesized records, each with a different value for reinforcement.

11



Recall that our simple model is calculating density and Young’s modulus for a hybrid material using the rule
of mixtures:

Density, 5 = fp, + (1 = f)pm
Young’s Modulus, £ = fE, + (1 — f)E,,
The example code below shows two methods that calculate density and Young’s modulus. Note that:

e The method name is followed by an empty pair of brackets ().
e The calculation code is enclosed in a pair of curly brackets { }.
e The word return tells the method to return the result of the calculation.

The model has already been set up to ask for reinforcement volume fraction (f) as a percentage. This is
assigned to the variable percentage. In the calculations below, this is divided by 100 to convert it into a
fraction.

When adding calculations to your model it is important to remember that the source data will be provided in
the requested ‘Data’ unit (see section 4.3) and that the calculated value will be returned in the specified
‘Calculated Data’ unit. As a result, it is important to ensure that your equations are set up to calculate in
these units:

[CalculatedData("Density", "kg/m~3")]
public double Density()

{

return (percentage / 100.0) * reinforcement.Density
+ (1 - percentage / 100) * matrix.Density;

}

[CalculatedData("Young's modulus", "GPa")]
public double YoungsModulus()

{

return (percentage / 100.0) * reinforcement.YoungsModulus
+ (1 - percentage / 100) * matrix.YoungsModulus;

Note: calculation methods calculate a point value for each property. If the material data in the installed
database is saved as a range value (e.g., Young’s modulus = 2.0 — 2.9 GPa), these will be converted to point
values using the geometric mean (i.e., square root of the product of the min and max values).

12



5 Running the Model

5.1 Building the Model

Once you have created your model, the next step is to compile the model. To do this:

1. Go to the Build menu in Visual Studio and select Configuration Manager. In the resulting dialog,
ensure that the current project is configured to build in ‘Release’ mode by adjusting the drop-down
list in the Configuration column. Once this is done, close the dialog.

2. Go to the Build menu in Visual Studio and select Build Solution. If you’ve made an error you'll be
told. The module won’t compile and you’ll need to fix the problem (typically this will be an error in
syntax, such as a missing ‘Y or *;"). Assuming that the solution compiled successfully, you can add the
model to the software.

5.2 Adding the Model to the Software

The CES EduPack or CES Selector software won’t be able to use your new Hybrid Synthesizer model until you
put the compiled module in the correct place. The module builds to a .dll file under the bin\Release folder of
the sample, but we need to move it to a place where CES can find it.

To do this, you should make a folder under your CES EduPack or CES Selector installation named plugins. The
software is normally installed under C:\Program Files\, but if you are running a 64 bit operating system,
you'll typically find it under C:\Program Files (x86)\. Copy the model .dll file to the plugins folder, as shown
below. The .dll file you need is the one that matches your Visual Studio project name. The other files in the
release folder are not necessary—this is the only file that you need to copy. Note that you might require
administrator privileges to do this.

Organize =] Open with... Burn New folder =~ I @ Organize = 57 Open with... Burn New folder =~ 0 @
4 | BampleModels = Name Date modified Type CES Selector 2013 *  Name : Date modified
4 c# = T Config - -
%] Granta.Data.dll Application exte %] Simple.CSharp.dll 15/11/201211:15
Advanced . - Database — -
|| Granta.HybridBase.dll Application exte :
4 Simple = . . . Guides
. C = Granta.HybridBasexml 02/ XML Document
4 1 bin 3 . . Papers
\%| Simple.CSharp.dll Application exte

Debug plugins

& Simple.CSharp.pdb 01212:36 Program Debug
. Release | Samples

Now start CES EduPack or CES Selector. When you run the Hybrid Synthesizer, you should see your new
model in the list of available models.

13



6 Defining a Model: Part 2—Extra Features

In this section we will introduce several new concepts that will simplify the definition of calculations.

6.1 Adding Model Parameters

Model parameters are similar to model variables, except they can only take a single value rather than varying
across a range or list. To add a parameter, add a field of type double to the model class and mark it as a
parameter as follows:

[Parameter("Name", "Unit", "Description")]

Just like variables, parameters can be constrained to certain values by using [Bounds(LowerBound,
UpperBound)].

As an example, if we want the user to supply a single value for “Parameter X”, we can define it as a model
parameter:

[Parameter("Parameter X", "%", "Specify a value for X")]
[Bounds (LowerBound = 0)]
public double percentage = 190;

Note, in the example above, a default value of 10 has been specified as part of the field definition.

6.2 Using Calculated Parameters

Sometimes there is benefit in simplifying calculations by pre-calculating certain values. For example, in the
Simple model we can simplify the density and Young’s modulus calculations by pre-calculating the volume
fraction of reinforcement (f,) and matrix (f,). As we don’t want these values to be added to the resulting
datasheet, these calculations will be marked as private. If percentage is the reinforcement percentage, then
the fractional values are defined as:

fr = percentage /100
fm =1 —( percentage /100)
Written as code, this becomes:

private double fr

{
get { return (percentage / 100); }
}
private double fm
{
get { return (1 - percentage / 100); }
}

The values for fr and fm can then be used in the existing density and Young’s modulus equations as follows:

[CalculatedData("Density", "kg/m"3")]
public double Density()

{

return fr * reinforcement.Density + fm * matrix.Density;

}

[CalculatedData("Young's modulus", "GPa")]
public double YoungsModulus()

14



{

return fr * reinforcement.YoungsModulus + fm * matrix.YoungsModulus;

}

We could also use this technique if we want to add price (C). If we assume that the price of a hybrid
material is based simply on the cost of the constituent components, then the price can be defined as follows:
Price, C~ — JrPrCrt+fm-Pm-Cm

p

In this case, the method to calculate price will use three pre-calculated values, the public double g (the
density of the final hybrid material), which we have already defined as one of the model calculations (see
section 4.7) and the fr and fm values:

[CalculatedData("Price", "currency/kg")]
public double Price()

{

return (fr * reinforcement.Density * reinforcement.Price + fm * matrix.Density *
matrix.Price) / Density();

In order for this method to access the price of the reinforcement and matrix materials, the following field
must be added to the SourceData class:

[Data("Price", "currency/kg")]
public double Price;

6.3 Using Equation Logic and Standard Functions

In certain cases, the performance of a material will be dependent on how the material behaves under certain
load conditions. For example, the compressive strength of unidirectional composites is determined by the
stress at which compressive fiber failure and fiber kinking occurs, with the final strength being determined
by the failure mechanism that occurs at the lowest load. As a result we can define the compressive strength
calculation as follows,

0. =0.75fo.,+ (1 —f)o,;, : compressive fiber failure
Lesser of
0. =140y : fiber kinking

We'll need to write a little bit of logic to return the correct result. The method shown in the example below
calculates both possible values for compressive strength and then uses the built-in Math.Min method to
return the minimum of these two values:

[CalculatedData("Compressive strength", "MPa")]
public double CompressiveStrength()

{
var csl = 0.75 * fr * reinforcement.CompressiveStrength +
fm * matrix.CompressiveStrength;
var c¢s2 = 14.0 * matrix.YieldStrength;
return Math.Min(csl, cs2);
}
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In order for this method to access the compressive strength and yield strength of the reinforcement and
matrix materials, the following fields must be added to the SourceData class:

[Data("Compressive strength", "MPa")]
public double CompressiveStrength;

[Data("Yield strength (elastic limit)", "MPa")]
public double YieldStrength;

Note: there are a number of built-in fields and functions that are frequently used in scientific equations, e.g.,
Pi, Pow, Sqrt, Min, Max, Log, Log10, Exp, Sin, Cos, Tan. More information on these, and numerous other
functions, can be found at:

http://msdn.microsoft.com/en-us/library/system.math.aspx

7 Defining a Model: Part 3—Advanced Features
The code associated with the features explained in this section is listed in full in Appendix A and is
incorporated in the Advanced model sample file.

7.1 Reusing Calculations
In our model we calculate density, Young’s modulus, and price using the rule of mixtures (RoM):

Density, p = fp, + (1 = f)pm
Young’s Modulus, £ = fE, + (1 — f)E,,

forCr+(1=f)pm-Cm

p

Price, C =

When we implemented this in the Simple model, we wrote the RoM calculation out in full for each property.
However, we can improve that code by creating a calculation method for the rule of mixtures and calling it
from the Density, Young’s Modulus, and Price methods. To do so, we create a method that takes two values
for the source material and returns the value for the hybrid material using the reinforcement percentage,
percentage. The code for the other calculations can then use this method, as shown below:

[CalculatedData("Density", "kg/m~3")]
public double Density()
{

}

[CalculatedData("Young's modulus", "GPa")]
public double YoungsModulus()

{
}

return RuleOfMixture(reinforcement.Density, matrix.Density);

return RuleOfMixture(reinforcement.YoungsModulus, matrix.YoungsModulus);

[CalculatedData("Price", "currency/kg")]
public double Price()

{
return RuleOfMixture(reinforcement.Density * reinforcement.Price,
matrix.Density * matrix.Price) / Density() ;
}
private double RuleOfMixture(double a, double b)
{

var f = percentage / 100;
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return £ * a + (1.0 - f) * b;
}

Note that the RuleofMixture method has been defined as private: it is not visible outside the model class.

7.2 Adding a List of Options

In certain models you may want the user to pick a parameter value from a list of options. This is shown in the
Hybrid Synthesizer user interface as a drop-down list. To do this, we need to use something known as an
enumeration, or enum. An enumeration defines a list or a set of named values that a field can take. We are
going to extend our example model to allow the user to specify whether the reinforcement orientation is
unidirectional or quasi-isotropic. To do so, we will create an enumeration that lists these two options, and a
field to hold the option that the user has selected.

The example below creates an enum named [& . ] =

Advanced Model (C#)

LaminateType that can take two values—Unidirectional
and Quasilsotropic. The [Optionltem] markup is added
to specify what is displayed in the Hybrid Synthesizer
user interface, specifically the two entries in the

A more advanced example model.

Matrix

‘Laminate’ drop-down list. Matr [B righ censiy conarre | (o]

Reinforcement B carbon stee, 54216 (Type W), cast annesled | [ Browse.. |

To make use of whichever option the user selects, we

Reinforcement percentage 10-70 % MNumber of values: 7

create a field of the enum type (LaminateType) and | i [unisiecionsl fiser =

Record Naming

mark it as an option. The name is used to label the | v Concete

Reinforcement Stee|

option in the user interface, and the description is used
as a tooltip:

This madel wil generate 7 records Previous | [ Create | [ concel

[Option("Name", "Description")]

Here is the full code for creating a list of options, and setting the default value to Unidirectional:

public enum LaminateType

{
[OptionItem("Unidirectional fiber")]
Unidirectional,
[OptionItem("Quasi-isotropic fiber")]
QuasiIsotropic,

}

[Option("Laminate", "Pick a laminate")]
public LaminateType laminate = LaminateType.Unidirectional;

The code below uses the value of the laminate field to modify the calculation of Young’s modulus. If the
laminate is Unidirectional, the calculation simply uses the rule of mixtures, but if the laminate is Quasi-
Isotropic, the rule of mixtures is calculated using only 0.5 of the reinforcement value. We are using a switch
statement to change the calculation based on the laminate type. In practice the value of the field laminate
will always be set to Unidirectional or Quasi-Isotropic and a suitable value calculated, but we need to cater
for the hypothetical case where the fields is blank, otherwise we will get a compilation error. This is handled
by the default statement, which returns a special constant, double.NaN, which simply means that the model
failed to calculate a value.

[CalculatedData("Young's modulus”, "GPa")]
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public double YoungsModulus()

{
switch (laminateType)

{

case LaminateType.Unidirectional:
return RuleOfMixture(reinforcement.YoungsModulus, matrix.YoungsModulus);

case LaminateType.QuasiIsotropic:
return RuleOfMixture(®.5 * reinforcement.YoungsModulus, matrix.YoungsModulus);

default:
return double.NaN;

7.3 Modifying Record Naming

To assist with creating meaningful and unique names for synthesized records, a model can be configured to
take abbreviated names for the source materials, in the ‘Record Naming’ section of the user interface. The
Hybrid Synthesizer will automatically generate an appropriate name for the resulting records based on these
abbreviated names. To add these abbreviated names, use the following markup for each source material:

[RecordName(“Name”, “Tooltip”)]

For instance, for the example model, the names “Matrix” and “Reinforcement” could be used to generate a
meaningful name for each record produced by the model:

[RecordName(“Matrix”, “Abbreviation used in the record name”)]

[RecordName(“Reinforcement”, “Abbreviation used in the record name”)]

7.4 Arranging the Layout of the User Interface

As you have seen, the Hybrid Synthesizer will automatically create a user interface based on the custom
model. However, it is possible to set the order in which the elements appear on the user interface. This can
be achieved using the following markup:

[Group(“GroupName”, orderNumber)] B

Advanced Model (C#)

Elements marked with the same GroupName will A sivensed ample mocel

appear together in the user interface. The order
number (which should not be enclosed in quotation

marks) is used to specify the order in which the element ||mst
Matrix [ B High censity concrete | [ Browse.. |

appears in the user interface. The numbering does Not | . urcemen

Reinforcement B carbon steel 54216 (Type Q) cast, annealed | [ Browse.. |

need to be sequential. For best results, it is

Reinforcement percentage 10-70 % Number of values: 7

recommended that numbering is unique across the | ... [re——— =

Record Naming

groups in the order in which you wish the elements to

Matrix Concrete

appear. The advanced example model uses this feature | rerforemen steef

This model will generate 7 records Previous | [ Create | [ cancel

to override the default element arrangement:

[Material("Matrix",

"Matrix material")]
[Group("Matrix", 1)]
public SourceData matrix;
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[Material("Reinforcement",
"Reinforcement material™)]

[Group("Reinforcement"”, 2)]

public SourceData reinforcement;

[Variable("Reinforcement percentage",
"%", "Specify the volume fraction")]
[RangeValues(Start = 10, End = 70, Number = 7, Logarithmic = false)]
[Bounds(@, 70)]
[Group("Reinforcement", 3)]
public double percentage;

[Option("Laminate", "Pick a laminate")]
[Group("Reinforcement", 4)]
public LaminateType laminate = LaminateType.Unidirectional;
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7.5 Changing Model Images

Models can be grouped so that, when the Hybrid Synthesizer is opened, the models appear in the same
section of the user interface. Each group has a thumbnail image and, when clicked, each model has its own
image.

. = I ==

Hybrid Synthesizer Advanced Model (C#)

Choose a model ."; Amore advancad example model.

Cellular Structures 08 O Composites (Simple Bounds)
Foam, closed-cell Continuous fiber (UD & QI)
= Particulate

Short fiber

Matrix

Controlled Thermal Expansion ([ _ Examples

Dual material lattice LU,

Simple
Simple Mod

Matrix [ & Browse fora record | [ Browse.. |

Reinforcement

Reinforcement [ Bl Browse forarecord | [ Browse. |

Multi-layer Materials Part cost Reinforcement percentage 10-70 % MNumber of values: 7

o W

Laminate [Unidirectional fiber -

Record Naming

Matrix *

= Reinforcement *

As explained in section 4.4 (Defining the model) above, the thumbnail image for a group of models is set by
marking up the model class with the following:

[ModelGroup("Examples", "UserModel.thumbnail.png")]
The image for each model is set by marking up the model class with the following:
[Image("UserModel.model.png")]

thumbnail.png is the image used for the thumbnail image and is 64 pixels wide and 64 pixels high. model.png
is the image displayed at the top of each model and is 200 pixels wide and 125 pixels high.

These images can be replaced with your own custom images provided that:

the image is in .png format;
the image is of the correct dimensions;
the name of the image matches the name as set out in the model code; and

P wnN e

the image is located in the same file directory as the Visual Studio project.

20



Once the image has been replaced, it must be added to the Visual Studio project as an embedded resource.

To do this, right click on the relevant project in the Visual Studio solution explorer and on the Add menu,

click Existing Item.

Quick Launch (Ctrl+Q)

D-ﬁlxi

- B ~1x
-renailm &
E @ B ’
T Search Solution Explorer (Ctrl+;) P
3] Solution ‘Examples.CSharp' (2 projects)
T ]
b & Prop & Build '
b =m Refe Rebuild
b o= Adv Run Code Analysis
H thur
4 B Simple. Scopeto This
b Prop B New Solution Explorer View
b COR=: Project Dependencies.
Blmoc fect Buiid Ord
b o sim| roject Build Order...
H thur Add v New Ttem... Ctrl+Shift+A
Add Reference... Existing Item... Shift+Alt+A
Add Service Reference... New Folder

Manage NuGet Packages...

(N3

Set as Startlp Project
Debug

Add Selution to Source Control.

= W

Cut
@ Paste

Windows Form..

User Control...

0w 60O

Class..

ShiftAlt=C

Ctrl+ X
CtrleV'

In the resulting dialog, navigate to the .png image file and click Add (you will need to change the filter
settings in the drop-down list above the Add button to either Image Files or All Files so that your .png image
file will be visible). The image should now appear in the Visual Studio solution explorer.

Right click on the image in the Visual Studio solution explorer and click Properties. In the Visual Studio
Properties window, change the Build Action attribute to Embedded Resource:

Properties
madelpng File Properties
13
& Advanced

Build Action

Embedded Resource

Capy to Output Directory

Custom Tool

Custom Tool Namespace
B Misc

File Name

Full Path

Nene
Compile

Content

Embedded Resource
CodeAnalysisDictionary
ApplicationDefinition

Page

Resource

SplashScreen

DesignData
DesignDataWithDesignTimeCreatableTypes

Build Action
How the file relates to the build and deployment processes.

—

Now, when the project is built and the .dll is copied to the plugins folder, the new image should appear in

the Hybrid Synthesizer user interface.

8 Further Information

For further information or assistance on how to create a model for the Hybrid Synthesizer, please contact

support@grantadesign.com.

If your enquiry relates to coding of a particular mathematical expression or function, we recommend that

you visit the following website in the first instance:

http://msdn.microsoft.com/en-us/library/system.math.aspx
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Appendix A—Source Listing (Advanced Model)

using System;
using System.ComponentModel.Composition;
using Granta.HybridBase;

namespace UserModel
{
#tregion Source Material Data Definition
public class SourceData
{
[Data("Density", "kg/m”~3")]
public double Density;

[Data("Young's modulus", "GPa")]
public double YoungsModulus;

[Data("Compressive strength"”, "MPa")]
public double CompressiveStrength;

[Data("Yield strength (elastic limit)", "MPa")]
public double YieldStrength;

// When requesting price data, the unit takes the form currency/kg:
[Data("Price", "currency/kg")]
public double Price;

}

#endregion

[Export("Granta.HybridModel")]
[Model("Advanced Model (C#)", "A more advanced example model.")]
[Image("UserModel.model.png")]
[ModelGroup("Examples", "UserModel.thumbnail.png")]
public class ExampleModel
{
[Material("Matrix", "Matrix material")]
[Group("Matrix", 1)]
public SourceData matrix;

[RecordName ("Matrix", "Abbreviation used in record name")]
public string _matrixName;

[Material("Reinforcement"”, "Reinforcement material")]
[Group("Reinforcement™, 2)]
public SourceData reinforcement;

[RecordName("Reinforcement", "Abbreviation used in record name")]

public string _reinforcementName;

[Variable("Reinforcement percentage", "%", "Specify the volume fraction")]
[RangeValues(Start = 10, End = 70, Number = 7, Logarithmic = false)]
[Bounds(@, 70)]

[Group("Reinforcement", 3)]

public double percentage;

// If we want the user to pick from a list of options, we need to
// create an enum to hold the possible choices.
// Each option (enumerator) can be marked up with the [OptionItem] attribute,
// which takes the description used in the UI combobox.
public enum LaminateType
{
[OptionItem("Unidirectional fiber")]
Unidirectional,
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[OptionItem("Quasi-isotropic fiber")]
QuasiIsotropic,

}

// The laminateType option that will be used in the calculations.

// The field must be marked as [Option] and requires a name and a description.
[Option("Laminate", "Pick a laminate")]

[Group("Reinforcement”, 4)]

public LaminateType laminate = LaminateType.Unidirectional;

#region Calculations
// Density is calculated by calling the method RuleOfMixture:

[CalculatedData("Density", "kg/m"3")]
public double Density()

{
}

return RuleOfMixture(reinforcement.Density, matrix.Density);

// Price - remember the unit should be in currency/kg:
[CalculatedData("Price", "currency/kg")]
public double Price()
{
// Price is calculated as a rule of mixture, using the density
return RuleOfMixture(reinforcement.Density * reinforcement.Price, matrix.Density
* matrix.Price) / Density();

}

// The Young's Modulus calculation changes depending on the laminateType.
// The Unidirectional laminate uses the normal Rule Of Mixture.
// The QuasiIsotropic laminate calculates a value using the RuleOfMixture, but
// with only 0.5 * the reinforcement.
[CalculatedData("Young's modulus", "GPa")]
public double YoungsModulus()
{

switch (laminate)

{

case LaminateType.Unidirectional:
return RuleOfMixture(reinforcement.YoungsModulus, matrix.YoungsModulus);

case LaminateType.QuasiIsotropic:
return RuleOfMixture(0.5 * reinforcement.YoungsModulus,
matrix.YoungsModulus);

default:
return double.NaN;

}

[CalculatedData("Compressive strength", "MPa")]
public double CompressiveStrength()
{
switch (laminate)
{
case LaminateType.Unidirectional:
{
var csl = RuleOfMixture(®.75 * reinforcement.CompressiveStrength,
matrix.CompressiveStrength);
var cs2 = 14.0 * matrix.YieldStrength;
return Math.Min(cs1, cs2);
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case LaminateType.QuasiIsotropic:
{
var csl
matrix.CompressiveStrength);
var cs2 = 14.0 * matrix.YieldStrength;
return Math.Min(csl, cs2);

RuleOfMixture(@.25 * reinforcement.CompressiveStrength,

¥
default:
return double.NaN;
}
¥
#endregion

// The Rule Of Mixture implemented as a helper method, and reused in the calculations

above.
private double RuleOfMixture(double a, double b)
{
var f = percentage / 100;
return f * a + (1.0 - f) * b;
}
}
}
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Appendix B—Model References and Properties

In order to build a model, you'll need to add a reference to the Hybrid Synthesizer library. You can do this by
right-clicking on the project name e.g., ‘Simple.CSharp’, and selecting Add Reference from the context
menu, as shown in the screen below:

n Examples.CSharp - Microsoft Visual Studio Express 2012 for Windows Desktop Quick Launch (Ctrl+Q) P = 0 X
FILE EDIT VIEW PROJECT BUILD DEBUG TEAM TOOLS TEST WINDOW  HELP |
Bl < IR B o g - - P Start ~ Release - AnyCPU - A _: n _
g_| Simple.cs® ® X Advanced.cs - ¥ 0
ér #3 UserModel.SourceData - @ & Buid -2 0o
i System; i
lusing Systenbc ode1.c Rebuild on Explorer (Ctrl+)

us:!.ng y=Ttem. Lampanen e Lomp Run Code Analysis i

using Granta.Framework; humbnail.png o

using Granta.HybridBase; Scope to This

using Granta.Hybridsynthesizers (1 New Solution Explorer View roperties
eferences
- - vbri Project D d
E[steps to create a hybrid model] FHEE A ENE B Granta.Data
Project Build Order...
Snamespace UserModel L ® Granta.Framework
{ Add » W Granta.HybridBase
| |_i5t of all properties used R B Granta.HybridSynthesizer
B Microsoft.CSharp
public class Scu'ceBataEl Add Service Reference... W System
| i . # Manage NuGet Packages.. B System.CompenentModel.Cor
= #region Model name, images a L3 Setas StartUp Project B System.Core
00% - 4 Debug , @ System.Data
B System.Data.DataSetExtensions
Output Ed  Add Solution to Source Control... - w1 -
4
Show cutput from:  Build ¥ cut Ctrl+X
FIE— Rebuild All started: Projec _— X
1>C:\Windows\Microsoft .NET\Framework - o arp Project Properties .
1> simple.CSharp -> E:\GIT\cesisrc_ X Remove Del
=== Rebuild All: 1 succeeded, oo 2
Unload Project 3 Simple.CSharp.csproj =
4
Error List | Qutput @ Open Folder in File Explorer

In the Reference Manager, click Browse. Browse to the installation folder for CES EduPack or CES Selector
(e.g., C:\Program Files (x86)\CES xxxxxxx\) and select (by holding down the Ctrl key) Granta.Data.dll and
Granta.HybridBase.dll. Click Add to add the reference.

B¢ Eomples.CSharp - Microsoft Visual Studio Express 2012 for Windows Desktop (Administrator] Quick Launch (Ctrl+ Q) P - B X
FILE EDIT VIEW PROJECT BULD DEBUG TEAM TOOLS TEST WINDOW HELP
e - < & < P Start + Release ~ AnyCPU - n -
g [Simplecs # X Advancedd Geiect the files to reference..
g *%UserModel.SourceData y - -2 0dE &
: R = | <« Program File... » CESSelector 2013 » - Search CES Selector 2013 2
Flusing System; Bon Explorer (Chrle: p-
using System.Compg — fon Explorer (Ctrl+:)
using Granta.Hybrd| Organize = New folder i~ Fl @ | b sxemples.Coharp' (2 projects)
] " B e CSharp
Steés to create 4 RjEroiscs Name Dt modfied Trpe | Pple.CSharp
S — [ epriib.an 18/10/201203:56  Applic ropert
Reference Manager - SimpleCSlll| % Favarites %) gddac.di 18/10/20120340  Applic
b Assemblies B Desitop % Granta.BarChart.dil 18/10/200203:55  Applic | [ Granta.Data
e 8 Downloads || Granta.CES Windows.dll 18/10/2012 03:54 Applic '8 Granta.HybridBase
olution . )
{ %l Recent Places %] Granta.Charting.dil 181020120355 Applic IR Microsoft.CSharp
N
b coM | %] Granta.Coredi 181020120353 Appic| (IS :”zem G i
. 5 Libraries A (R 07 : A P SRS
Frares | 1% Granta.Data.dll 181020120354 Applic] lBa 5 i care
= % Documents % Granta.Data Values.dll 18/10/20120354  Applic— - System.Data
ecent
il Git % Granta.Framework.dil 18/10/20020353  Applic | |[#® System .Data.DataSetExtensions
o) Music | /%) Granta.HybridBase.dIl 18/10/2012 03:55 Applic B System.Xml
=] Pictures ] Granta.HybridSynthesizer.dil 18/10/20120355  Applic [l SystemXmlling
[ videos %] Granta.PresentationFramework.dil 18/10/2012 03:54 Applic ‘h”
j
% Granta.ProductDesign.dll 18/10/201203:55  Applic =
18 JAMESB 22| Granta.ProductDesign.Reporting.dil 18/10/2012 03:59 Applic imple.cs
£ Local Disk () || Granta.ProductDesign.ULdll 18/10/2012 03:59 Applic imple.CSharp.sin
= .Luzam\;k(m o e — = s i -~ humbnail.png
' ” »
File name: "Granta.HybridBase.dil" "Granta.D. ~ | Companent Files y P
I :

3

Browse.. | [
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Similarly, add a reference to the Microsoft.Net library System.ComponentModel.Composition, as shown in
the screen below. In the Reference Manager, click Assemblies, then click Framework. To find the library, use
the scroll bar or the search in the top right of the Reference Manager. If there are several versions of the
library available, check the box for the 4.0 version. Click OK to close the Reference Manager.

DQ Examples.CSharp - Microsoft Visual Studio Express 2012 for Windows Desktop Quick Launch (Ctrl+ Q) P = & X
FILE EDIT VIEW PROJECT BULD DEBUG TEAM TOOLS TEST WINDOW HELP
BN G- B Start - Release - Any CPU - n -
g Simplecs® # X Advanced.cs B solution Explorer SRR
g *3 UserModel.SourceData -|@ YoungsModulus - @& -2 ET' ;.
Hfstep hubeid modell £ B
prer (Ctrl+;) P~
~Inamesp: Usel — es -~
t 4 Assemblies Targeting: .NET Framework 4 P~
@
) Framework Name * Mame: d.cs
®  public clf Extensions ReachFremework System.ComponentModel.Comp | g Csharpsin
sysglobl osition "
El #region M| b Selution System Created
System Activities Microsoft Corporation
El #/ In ordf P COM System. Activities. Core.Presentation Version:
11 mark Gl b Browse System Activities.Durablelnstancing 4000
/4 add thil System Activities.Presentation File Version: -
System.Addln 40303191 -
of | System.Addln. Contract I o
System.ComponentModel.Composition. jj romewor
System.ComponentModel.DataAnnotations. o HybridBase
System.Configuration & HybridSynthesizer
System.Configuration.Install bsoft.CSharp
System.Core
System.Data .ComponentModel.Cor
= System.Data.DataSetExtensions Core
System.Data.Entity Data

System.Data.Entity.Design
System.Data.Ling

[Mate System.Data.OracleClient ‘X_m\ _ -
00% 4 ] System.Data.Services - S
Output wwwww ) (s - x
Show output from: B ct Properties o
Rebuild
1>C: \Windows\Microsoft.NET\Framework\v4.8.38319\Microsoft . Common. targets(1578,5): warning MSB327@: Project File Senpie CShorprcspros [

1> Simple.Csharp -> E:\GIT\ces\src syntnesuer\fxamplenonels\c;:\smpla\mn\Release\sxmple Csharp.

Rebuild All: 1 succeeded, @ failed, @ skipped = Project Folder

- Misc

Error List | Output

You can also change the output file name (.dll) by using the Project menu and selecting
<your project name> Properties (the last entry in the menu). The window should appear as shown below,
where, under Application, you can modify the Assembly name to reflect that of your model. Now when you
build your model, it will create a .dIl with your model name.

Bq Examples.CSharp - Microsoft Visual Studio Express 2012 for Windows Desktop Quick Launch (Ctrl+Q) P = & X%
FILE EDIT VIEW PROJECT BULD DEBUG TEAM TOOLS TEST WINDOW HELP

0~ ol e B Start - Release - AnyCPU .

g Advanced.cs ~ Solution Explorer =iz

§ [} -&aa

/A Platforms [ N/A ) )
Search Solution Explorer (Crl+)

Build Events Assembly name: Default namespace: a s . EE‘““‘“ -

e — - in
Debug Fimple.Cohare UserModel b Pl
Resources Target framework: Output type: b Advanced.cs
Services [.NET Framework 4 ~| [Class Library Advanced.CSharp.sin

model.png

SEHEE Startup object: thumbnail.png

Reference Paths [t set) -] Assembly Infc 4 Simple.CSharp
b M Properties

SR U 4 i@ References
Code Analysis 8 Granta.Data

Specify how application resources will be managed: 8 Grants Framewerk
Granta.HybridBase
Granta.HybridSynthesizer
Microsoft.CSharp

i

@ Icon and manifest
A manifest determines specific settings for an application. To embed a custom manifest, first
your project and then select it from the list below.

System
Icon:
B System.ComponentModel.Cor
(Default Icon) - System.Core
anifes System.Data
Embed manifest with default settings = Systemn.Data DataSetBxtensions
- = Systen.Xml -
< il » - .
4 »
UL 500 L OSSO0 3o [) 53 VIS S e > o x

Show output from:  Build - #a

1>------ Rebuild All started: Project: Simple.CSharp, Configuration: Release Any CPU ------ - 'z’l-
1>C:\Windows\Microsoft.NET\Framework\v4.8.38319\Microsoft .Common. targets(1578,5): warning MSB327a:

1> Simple.CSharp -» E:\GIT\ces\src_: synthEs1zEr\ExamplEHDdE1s\C#\S1mp15\b1n\RElEasE\SlmplE CSharp.

Rebuild All: 1 succeeded, ® failed, @ skipped ==

Error List | Output
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Appendix C—Debugging the Model
Note: This appendix shows the steps necessary to debug the model using Visual Studio Express. If you are
using the Standard Edition (or above) then you can debug your code by attaching to a running CES.exe.

To debug a model in Visual Studio Express, you’ll need to enable ‘expert’ settings and expose advanced build
configurations. You can do this as follows:

1. Onthe Tools menu, click Options.
2. In the resulting dialog, choose Projects and Solutions -> General. Check the option ‘Show advanced
build configurations’. Click OK.

You should be able to see the Release/Debug options in the toolbar now. Set the configuration to Debug.
Now your model should build to the bin\debug folder rather than the bin\release folder. Remember that
each time you make a change to your model; you must rebuild the solution and copy the output .dll to the
CES EduPack or CES Selector plugins folder.

If you try to debug your model (using Debug -> Start debugging) you’ll be greeted with an error message
saying that a project with an output type of Class Library cannot be started directly. The express editions of
Visual Studio do not have a direct way of specifying the startup application for debugging a library, but it can
be done by adding a separate configuration file in the project folder that specifies debugging options. Add a
file named ‘Simple.CSharp.csproj.user’ where Simple.CSharp is the project name. The file needs to contain
the following configuration information, customizing the file path in the StartProgram element to your
installation of CES.

<?xml version="1.0" encoding="utf-8"?>
<Project xmlns="http://schemas.microsoft.com/developer/msbuild/2003">
<PropertyGroup Condition=" '$(Configuration)|$(Platform)' == 'Debug|AnyCPU' ">
<StartAction>Program</StartAction>
<StartProgram>C:\Program Files\CES Selector 2013\CES.exe</StartProgram>
</PropertyGroup>
</Project>

You'll need to reopen your project file in order for this configuration to be detected. Remember to copy the
output of your bin\debug folder to the plugins folder before starting the debugger. It is important to ensure
that there are no line breaks or spaces before or after the file path in the StartProgram element.

If you are still having trouble getting the debugging to work after following the above instructions:

e Ensure that you have the Visual Studio project you are debugging open by itself and have not
opened a Visual Studio solution file containing the project.

e Open the Build -> Configuration Manager menu and ensure that the project is set to run in debug
mode in the Configuration column of the resulting dialog.
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